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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place
the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface.
Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows
or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface,
such as pillows or rugs or clothing, during operation. The device and the AC adapter comply with the
user-accessible surface temperature limits defined by the International Standard for Safety of
Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP Mini 1000
Netbook

Compaq Mini 700
Netbook

Product Name HP Mini 1000 Netbook √  

 Compaq Mini 700 Netbook  √

Processor Intel® Atom™ N270 1.6-GHz processor, 512-KB
Level 2 cache, 533-MHz front-side bus (FSB)

√ √

Chipset Northbridge: 945GSE; 533-MHz bus speed √ √

 Southbridge: ICH7M √ √

Graphics Intel® Graphics Media Accelerator 950 √ √

 Universal Memory Architecture (UMA) graphics
subsystem

√ √

Panels All display assemblies include 1 webcam,
1 microphone, 1 speaker box, and 2 wireless local-
area network (WLAN) antenna transceivers/
cables; wireless wide-area network (WWAN) is
optional

√ √

 Wide aspect 16:10 ratio panels √ √

 8.9-inch WSVGA BrightView (1024 × 600) LED √ √

 10.1-inch standard-definition AntiGlare
(1024 × 576) LED

√ √

 10.2-inch WSVGA AntiGlare (1024 × 600) LED √ √

Memory One customer-accessible/upgradable memory
module slot

√ √

 Supports up to 1 GB of system memory √ √

 PC2-4200, 533-MHz, DDR2 √ √

 Supports the following configurations:   

 ● 512-MB total system memory (512 × 1) √ √

 ● 1024-MB total system memory (1024 × 1) √ √

 ● 2048-MB total system memory (2048 × 1) √  
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Category Description HP Mini 1000
Netbook

Compaq Mini 700
Netbook

Mass storage devices Solid-state drive (SSD) based on multi-level cell
(MLC) technology

Configurations: 8-GB, 16-GB

Models equipped with a solid-state drive also
support the HP Mini Mobile Drive Bay

√ √

 Supports all 4.57-cm (1.8-inch) parallel ATA
(PATA) hard drives (optional)

Configuration: 60-GB, 4200-rpm

√ √

Optical drive Supports external USB optical drives only √ √

Diskette drive Supports external USB diskette drives only √ √

Audio High-definition (HD) audio - AD1984 √ √

 Integrated speakers (2) √ √

 Fixed integrated microphone √ √

Webcam Fixed integrated VGA webcam, 640 × 480
resolution, up to 30 frames per second

√ √

Modem Supports external USB modems only √ √

Ethernet Integrated 10/100 network interface card (NIC) √ √

Wireless 2 WLAN antennae built into display assembly √ √

 Integrated WLAN by way of Broadcom
BCM4312 802.11b/g WLAN module

√ √

 Integrated WWAN by way of HP un2400 Mobile
Broadband Module (optional)

√ √

 Integrated personal area network (PAN) by way of
Bluetooth® module (optional)

√ √

External media cards SD Card Reader supporting MultiMediaCard
(MMC) and Secure Digital (SD) Memory Card

√ √

 HP Mini Mobile Drive Bay (on models equipped
with a solid-state drive)

√ √

Internal media cards Two Mini Card slots:

● Full-size Mini Card slot

● Half-size Mini Card slot

√ √

Ports Audio-in (stereo microphone) √ √

 Audio-out (stereo headphone) √ √

 RJ-45 (Ethernet, includes link and activity lights) √ √

 USB (2) √ √

 3-pin AC power √ √
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Category Description HP Mini 1000
Netbook

Compaq Mini 700
Netbook

Docking Expansion port

Signals passed through expansion port:

● USB 2.0

● Headphone-out/stereo-out and stereo
microphone-in

● VGA-out

● Power-in

● Power (up to 50 W)

NOTE: Docking device will support RJ-45
through USB (no pass-through support on the
expansion port).

√ √

Keyboard/pointing device 92% keyboard √ √

 TouchPad, with 2 TouchPad buttons and 2-way
scrolling (taps enabled as default)

√ √

Power requirements 30-W UMA AC adapter (non-smart) with localized
cable plug support

√ √

 AC adapter connector on cable √ √

 3-cell lithium-polymer (Li-Pol) battery (2.4-Ah,
26-Wh), 3-hour target life

√ √

Security Supports HP Kensington Security Lock √ √

Operating system Preinstalled:   

 Windows® XP Home SP3, ultra low-cost personal
computer (ULCPC) edition

√ √

 Restore media:   

 Backup software provided by operating system CD
and recovery DVD

√ √

Serviceability End-user replaceable parts:   

 AC adapter √ √

 Battery (system) √ √

 Memory module √ √

 HP Mini Mobile Drive √ √
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2 External component identification

Top components
Display

Item Component Function

(1) Internal display switch Turns off the display if the display is closed while the power
is on.

(2) Speakers (2) Produce sound.

(3) Internal microphone Records and captures sound.

(4) Webcam Captures still photographs and videos.

NOTE: To capture videos, you will need to install
additional webcam software.
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Wireless antennae

Item Component Function

(1) WLAN antennae (2) * Send and receive wireless signals to communicate with
wireless local-area networks (WLANs).

(2) WWAN antennae (2) (select models only) * Send and receive wireless signals to communicate with
wireless wide-area networks (WWANs).

* The antennae are not visible from the outside of the device. For optimal transmission, keep the areas immediately around the
antennae free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. To access these notices, click Start > Help and Support >
User Guides.
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Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) Function keys Execute frequently used system functions when pressed
in combination with the fn key.

(3) fn key Executes frequently used system functions when pressed
in combination with a function key.

(4) Windows logo key Displays the Windows Start menu.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.
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TouchPad

Item Component Function

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) TouchPad on/off light ● White: TouchPad is on.

● Amber: TouchPad is off.

(3) Left TouchPad button * Functions like the left button on an external mouse.

(4) TouchPad * Moves the pointer and selects or activates items on the
screen.

(5) TouchPad scroll zone Scrolls up or down.

(6) Right TouchPad button * Functions like the right button on an external mouse.

* This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel > Printers
and Other Hardware > Mouse.
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Front components

Item Component Function

(1) Power light ● On: The device is on.

● Blinking: The device is in Standby.

● Off: The device is off.

(2) Power switch ● When the device is off, slide the switch to turn on the
device.

● When the device is on, briefly slide the switch to
initiate Hibernation.

● When the device is in Standby, briefly slide the switch
to exit Standby.

● When the device is in Hibernation, briefly slide the
switch to exit Hibernation.

If the device has stopped responding and Windows
shutdown procedures are ineffective, slide and hold the
power switch for at least 5 seconds to turn off the device.

To learn more about your power settings, select Start >
Control Panel > Performance and Maintenance >
Power Options.

(3) Drive light Blinking: The hard drive or flash drive is being accessed.

(4) Battery light ● On: A battery is charging.

● Blinking: A battery that is the only available power
source has reached a low battery level. When the
battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the device is plugged into an external power
source, the light turns off when all batteries in the
device are fully charged. If the device is not plugged
into an external power source, the light stays off until
the battery reaches a low battery level.

(5) Wireless light ● Blue: An integrated wireless device, such as a WLAN
device, is on.

● Amber: All wireless devices are off.

(6) Wireless switch Turns the wireless feature on or off, but does not establish
a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

8 Chapter 2   External component identification



Right-side components

Item Component Function

(1) Vent Enables airflow to cool internal components

NOTE: The device fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) SD Card Reader Supports the following optional digital card formats:

● MultiMediaCard (MMC)

● Secure Digital (SD) Memory Card

(3) USB port Connects an optional USB device.

(4) HP Mini Mobile Drive Bay (on models equipped with
a solid-state drive)

Connects an optional HP Mini Mobile Drive.

(5) Security cable connector Attaches an optional security cable to the device.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the device from being
mishandled or stolen.
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Left-side components

Item Component Function

(1) Power connector Connects an AC adapter.

(2) Power connector light ● On: The device is running on AC power.

● Off: The device is running on battery power.

(3) USB port Connects an optional USB device.

(4) Vent Enables airflow to cool internal components.

NOTE: The device fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) Expansion port Connects the device to an optional docking device or an
optional expansion product.

(6) Audio-out (headphone) jack/Audio-in (microphone)
jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety and Environmental Notices.

NOTE: When a device is connected to the jack, the
device speakers are disabled.

(7) RJ-45 (network) jack Connects a network cable.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Memory module compartment Contains the memory module slot.

NOTE: The release latch for the memory module
compartment cover (not illustrated) is located underneath
the right battery release latch (see Memory module
on page 38).

(4) Vent Enables airflow to cool internal components.

NOTE: The device fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

Bottom components 11



3 Illustrated parts catalog

Serial number location
The service tag, affixed to the bottom of the device, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the device.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the device.

(5) Warranty period: This number describes the duration of the warranty period for the device.

When ordering parts or requesting information, provide the device serial number and model description
provided on the service tag.
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Device major components

Item Description Spare part number

(1) Display assembly (includes 1 webcam, 1 microphone, 1 speaker box, and 2 WLAN antenna
transceivers/cables; WWAN is optional)

 

 8.9-inch WSVGA BrightView (HP Mini 1000) 507309-001

 8.9-inch WSVGA BrightView (Compaq Mini 700) 508638-001

 10.1-inch standard-definition AntiGlare (HP Mini 1000) 507312-001

 10.1-inch standard-definition AntiGlare (red-colored HP Mini 1000) 509696-001

 10.1-inch standard-definition AntiGlare (Compaq Mini 700) 509697-001

 10.2-inch WSVGA AntiGlare (HP Mini 1000) 507310-001
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Item Description Spare part number

 10.2-inch WSVGA AntiGlare (red-colored HP Mini 1000) 512140-001

 10.2-inch WSVGA AntiGlare (Compaq Mini 700) 512143-001

 See Display assembly components on page 17 for more spare part information.  

(2) Keyboard

NOTE: For a comprehensive list of keyboard spare part numbers, see the Sequential part number listing
on page 24.

 For use with standard device models 504611-xx1

 For use with red-colored HP Mini 1000 models only 509650-xx1

(3) Top cover (includes TouchPad) 504612-001

 Mass storage devices

NOTE: Each hard drive spare part kit and solid-state drive spare part kit includes a cable and bracket.

(4a) Hard drive (select models only): 60-GB, 4200-rpm 504601-001

 Hard Drive Hardware Kit (not illustrated) 504607-001

(4b) Solid-state drive

 16-GB 507314-001

 8-GB 507313-001

(5) Fan 504615-001

(6) Heat sink assembly (includes replacement thermal material) 515099-001

 Cable Kit (see Cable Kit on page 19 for more spare part number information) 507708-001

(7a) Internal display switch module  

(7b) Bluetooth cable  

(7c) USB cable  

(7d) SIM card cable  

(7e) Power cable  

 Wireless modules

(8a) Broadcom 4312 802.11/b/g WLAN module

 For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

504593-001
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Item Description Spare part number

 For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-002

(8b) HP un2400 Mobile Broadband Module (select models only) 483377-002

 Plastics Kit (see Plastics Kit on page 21 for more spare part number information)  

(9a) HP Mini Mobile Drive Bay cover  

(9b) Memory module compartment cover  

(9c) SD Card Reader slot bezel  

(9d) Security cable connector  

 For the HP Mini 1000 and Compaq Mini 700 507317-001

 For the red-colored HP Mini 1000 512192-001

(10) RTC battery 507707-001

(11) System board (includes processor and replacement thermal material) 504592-001

(12) Bluetooth module (select models only)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 507708-001.

507706-001

(13) Base enclosure (includes 4 rubber feet)  

 For the HP Mini 1000 and Compaq Mini 700 506337-001

 For the red-colored HP Mini 1000 512189-001

(14) Memory module (PC2-4200, 533-MHz, DDR2)  

 512-MB 504599-001

 1024-MB 504600-001

 2048-MB (HP Mini 1000 only) 517577-001

(15) USB board 506336-001

Device major components 15



Item Description Spare part number

(16) Battery (3-cell, 26-Wh Li-Pol)  

 For the HP Mini 1000 and Compaq Mini 700 504610-001

 For the red-colored HP Mini 1000 (for use in all countries and regions except Germany) 512851-001

 For the red-colored HP Mini 1000 (for use in Germany only) 512851-002
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Display assembly components

NOTE: 10.1-inch display assembly components are not sold separately for the HP Mini 1000. The
complete display assembly is available as spare part number 509696-001 for the red-colored
HP Mini 1000 or 507312-001 for all other models of the HP Mini 1000.

NOTE: 10.2-inch display assembly components are not sold separately. The complete display
assembly is available as spare part number 512140-001 for the red-colored HP Mini 1000, 507310-001
for all other models of the HP Mini 1000, or 512143-001 for the Compaq Mini 700.

Item Description Spare part number

(1) Speaker grill 506338-001

(2) Speaker assembly (includes left and right cables) 506335-001

(3) Display bezel  

 For use with 8.9-inch panels on the HP Mini 1000 506333-001

 For use with 8.9-inch panels on the Compaq Mini 700 509701-001

 For use with 10.1-inch panels on the Compaq Mini 700 509704-001
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Item Description Spare part number

(4) Webcam module 

NOTE: The webcam module spare part kit does not include a webcam cable. An
integrated display/webcam cable for all 8.9-inch panels is included in the Display Cable Kit,
spare part number 504597-001 (with WLAN) or 504598-001 (with WWAN).

An integrated display/webcam cable for 10.1-inch panels (Compaq Mini 700 only) is
included in the Display Cable Kit, spare part number 515208-001 (with WLAN) or
515209-001 (with WWAN).

 

 For use with all 8.9-inch panels 504594-001

 For use with 10.1-inch panels on the Compaq Mini 700 515213-001

 Display Hinge Kit  

(5a) Left and right display panel brackets  

(5b) Left and right display hinges  

 For use with all 8.9-inch panels 504596-001

 For use with 10.1-inch panels on the Compaq Mini 700 515207-001

(6) Display panel  

 8.9-inch WSVGA BrightView for the HP Mini 1000 and the Compaq Mini 700 509698-001

 10.1-inch standard-definition AntiGlare for the Compaq Mini 700 509703-001

(7) Display Cable Kit (includes microphone assembly and display/webcam cable)  

 For use with all 8.9-inch panels; includes WLAN 504597-001

 For use with all 8.9-inch panels; includes WWAN 504598-001

 For use with 10.1-inch panels on the Compaq Mini 700; includes WLAN 515208-001

 For use with 10.1-inch panels on the Compaq Mini 700; includes WWAN 515209-001

(8) Display enclosure (includes logo)  

 For use with 8.9-inch panels on the HP Mini 1000 504595-001

 For use with 8.9-inch, 10.1-inch, and 10.2-inch panels on the Compaq Mini 700 509702-001

 Display Rubber Kit (not illustrated)  

 For use with all 8.9-inch panels 509699-001

 For use with 10.1-inch panels on the Compaq Mini 700 515210-001

 Display Screw Kit (not illustrated)  

 For use with all 8.9-inch panels 509700-001

 For use with 10.1-inch panels on the Compaq Mini 700 515211-001

 Foil shield (not illustrated)  

 For use with all 8.9-inch display panels 506334-001

 For use with 10.1-inch display panels on the Compaq Mini 700 515212-001
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Cable Kit

Item Description Spare part number

 Cable Kit: 507708-001

(1) SIM card cable  

(2) Power cable  

(3) Internal display switch module  

(4) Bluetooth cable  

(5) USB cable  
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Mass storage devices

NOTE: Each hard drive spare part kit and solid-state drive spare part kit includes a cable and bracket.

Item Description Spare part number

 Mass storage devices:  

(1) Hard drive (select models only): 60-GB, 4200-rpm 504601-001

 Hard Drive Hardware Kit (not illustrated) 504607-001

(2) Solid-state drive  

 16-GB 507314-001

 8-GB 507313-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit:  

 For the HP Mini 1000 and Compaq Mini 700 507317-001

 For the red-colored HP Mini 1000 512192-001

(1) Memory module compartment cover  

(2) HP Mini Mobile Drive Bay cover  

(3) Security cable connector  

(4) SD Card Reader slot bezel  
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Miscellaneous parts
Description Spare part number

Bracket Kit

● Actuators for power switch and wireless switch

● DC jack bracket (fits over power and USB ports)

● Internal display switch bracket

● RJ-45 connector bracket

● USB connector bracket

● WWAN connector bracket

507318-001

HP Mini Mobile Drive (supported on models equipped with a solid-state drive and HP Mini Mobile
Drive Bay)

 

2-GB 512329-001

4-GB 512330-001

8-GB 512331-001

HP Mini Sleeve  

For the HP Mini 1000 512321-001

For the red-colored HP Mini 1000 511844-001

Power cord

For use in Argentina (HP Mini 1000 only) 490371-D01

For use in Australia (HP Mini 1000 only) 490371-011

For use in Brazil (HP Mini 1000 only) 490371-201

For use in China (HP Mini 1000 only) 490371-AA1

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India (HP Mini 1000 only) 490371-D61

For use in Italy (HP Mini 1000 only) 490371-061

For use in Japan (HP Mini 1000 only) 490371-291

For use in North America (HP Mini 1000 only) 490371-001

For use in Singapore and the United Kingdom 490371-031

For use in South Africa 490371-AR1

For use in South Korea (HP Mini 1000 only) 490371-AD1

For use in Taiwan (HP Mini 1000 only) 490371-AB1

Rubber Kit (contains 4 device feet and RJ-45 cover) 504613-001
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Description Spare part number

Screw Kit

● Phillips PM1.6×2.5 screw

● Phillips PM1.6×4.0 screw

● Phillips PM1.6×6.0 screw

● Phillips PM2.0×3.0 screw

● Phillips PM2.0×4.5 screw

● Phillips PM2.5×5.0 screw

● Phillips PM2.5×7.0 screw

504614-001

30-W UMA AC adapter  

For use in all countries and regions except Germany 496813-001

For use in Germany only 512852-001
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Sequential part number listing
Spare part
number

Description

483377-002 HP un2400 Mobile Broadband Module

490371-001 Power cord for use in North America (HP Mini 1000 only)

490371-011 Power cord for use in Australia (HP Mini 1000 only)

490371-021 Power cord for use in Europe

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy (HP Mini 1000 only)

490371-081 Power cord for use in Denmark

490371-201 Power cord for use in Brazil (HP Mini 1000 only)

490371-291 Power cord for use in Japan (HP Mini 1000 only)

490371-AA1 Power cord for use in China (HP Mini 1000 only)

490371-AB1 Power cord for use in Taiwan (HP Mini 1000 only)

490371-AD1 Power cord for use in South Korea (HP Mini 1000 only)

490371–AR1 Power cord for use in South Africa

490371-D01 Power cord for use in Argentina (HP Mini 1000 only)

490371-D61 Power cord for use in India (HP Mini 1000 only)

496813-001 30-W UMA AC adapter for use in all countries and regions except Germany

504592-001 System board equipped with 1.6-GHz processor (includes replacement thermal material)

504593-001 Broadcom 4312 802.11/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

504593-002 Broadcom 4312 802.11/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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Spare part
number

Description

504594-001 Webcam module for use with all 8.9-inch panels

NOTE: The webcam module spare part kit does not include a webcam cable. An integrated display/webcam
cable is included in the Display Cable Kit, spare part number 504597-001 (with WLAN) or 504598-001 (with
WWAN).

504595-001 Display enclosure (includes logo) for use with 8.9-inch panels on the HP Mini 1000

504596-001 Display Hinge Kit for use with all 8.9-inch panels (includes left/right display hinges and display panel
brackets)

504597-001 Display Cable Kit with WLAN for use with all 8.9-inch panels (includes microphone assembly and display/
webcam cable)

504598-001 Display Cable Kit with WWAN for use with all 8.9-inch panels (includes microphone assembly and display/
webcam cable)

504599-001 512-MB memory module (PC2-4200, 533-MHz, DDR2)

504600-001 1024-MB memory module (PC2-4200, 533-MHz, DDR2)

504601-001 60-GB, 4200-rpm hard drive (includes cable and bracket)

504607-001 Hard Drive Hardware Kit

504610-001 3-cell, 26-Wh Li-Pol battery for the HP Mini 1000 and Compaq Mini 700

504611-001 Keyboard for use in the United States

504611-031 Keyboard for use in the United Kingdom (Compaq Mini 700 only)

504611-041 Keyboard for use in Germany (Compaq Mini 700 only)

504611-051 Keyboard for use in France (Compaq Mini 700 only)

504611-061 Keyboard for use in Italy (Compaq Mini 700 only)

504611-071 Keyboard for use in Spain

504611-131 Keyboard for use in Portugal (Compaq Mini 700 only)

504611-141 Keyboard for use in Turkey (Compaq Mini 700 only)

504611-161 Keyboard for use in Latin America (HP Mini 1000 only)

504611-171 Keyboard for use in Saudi Arabia (Compaq Mini 700 only)

504611-251 Keyboard for use in Russia

504611-281 Keyboard for use in Thailand (HP Mini 1000 only)

504611-291 Keyboard for use in Japan (HP Mini 1000 only)

504611-AB1 Keyboard for use in Taiwan (HP Mini 1000 only)

504611-AD1 Keyboard for use in South Korea (HP Mini 1000 only)

504611-B31 Keyboard for international use (Compaq Mini 700 only)

504612-001 Top cover (includes TouchPad) for the HP Mini 1000 and Compaq Mini 700

504613-001 Rubber Kit (contains 4 device feet and RJ-45 cover)

504614-001 Screw Kit

504615-001 Fan 
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Spare part
number

Description

506333-001 Display bezel for use with 8.9-inch panels on the HP Mini 1000

506334-001 Foil shield for use with all 8.9-inch display panels

506335-001 Speaker assembly (includes left and right cables)

506336-001 USB board

506337-001 Base enclosure (includes 4 rubber feet) for the HP Mini 1000 and Compaq Mini 700

506338-001 Speaker grill for the HP Mini 1000 and Compaq Mini 700

507309-001 8.9-inch WSVGA BrightView display assembly for the HP Mini 1000 (includes 1 webcam, 1 microphone,
1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

507310-001 10.2-inch, WSVGA, AntiGlare display assembly for the HP Mini 1000 (includes 1 webcam, 1 microphone,
1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

507312-001 10.1-inch, standard-definition, AntiGlare display assembly for the HP Mini 1000 (includes 1 webcam,
1 microphone, 1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

507313-001 8-GB solid-state drive (includes cable and bracket)

507314-001 16-GB solid-state drive (includes cable and bracket)

507317-001 Plastics Kit for the HP Mini 1000 and Compaq Mini 700 (see Plastics Kit on page 21 for more Plastics Kit spare
part number information)

507318-001 Bracket Kit

507706-001 Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 507708-001.

507707-001 RTC battery

507708-001 Cable Kit

508638-001 8.9-inch WSVGA BrightView display assembly for the Compaq Mini 700 (includes 1 webcam, 1 microphone,
1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

509650-001 Keyboard for use in the United States (red-colored HP Mini 1000 only)

509650-031 Keyboard for use in the United Kingdom (red-colored HP Mini 1000 only)

509650-041 Keyboard for use in Germany (red-colored HP Mini 1000 only)

509650-051 Keyboard for use in France (red-colored HP Mini 1000 only)

509650-061 Keyboard for use in Italy (red-colored HP Mini 1000 only)

509650-071 Keyboard for use in Spain (red-colored HP Mini 1000 only)

509650-131 Keyboard for use in Portugal (red-colored HP Mini 1000 only)

509650-141 Keyboard for use in Turkey (red-colored HP Mini 1000 only)

509650-161 Keyboard for use in Latin America (red-colored HP Mini 1000 only)

509650-171 Keyboard for use in Saudi Arabia (red-colored HP Mini 1000 only)

509650-251 Keyboard for use in Russia (red-colored HP Mini 1000 only)

509650-281 Keyboard for use in Thailand (red-colored HP Mini 1000 only)
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Spare part
number

Description

509650-291 Keyboard for use in Japan (red-colored HP Mini 1000 only)

509650-AB1 Keyboard for use in Taiwan (red-colored HP Mini 1000 only)

509650-AD1 Keyboard for use in South Korea (red-colored HP Mini 1000 only)

509650-B31 Keyboard for international use (red-colored HP Mini 1000 only)

509696-001 10.1-inch, standard-definition, AntiGlare display assembly for the red-colored HP Mini 1000 (includes
1 webcam, 1 microphone, 1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

509697-001 10.1-inch, standard-definition, AntiGlare display assembly for the Compaq Mini 700 (includes 1 webcam,
1 microphone, 1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

509698-001 8.9-inch WSVGA BrightView display panel for the HP Mini 1000 and the Compaq Mini 700

509699-001 Display Rubber Kit for use with all 8.9-inch panels

509700-001 Display Screw Kit for use with all 8.9-inch panels

509701-001 Display bezel for use with 8.9-inch panels on the Compaq Mini 700

509702-001 Display enclosure (includes logo) for use with 8.9-inch, 10.1-inch, and 10.2-inch panels on the
Compaq Mini 700

509703-001 10.1-inch standard-definition AntiGlare display panel for the Compaq Mini 700

509704-001 Display bezel for use with 10.1-inch panels on the Compaq Mini 700

511844-001 HP Mini Sleeve for the red-colored HP Mini 1000

512140-001 10.2-inch, WSVGA, AntiGlare display assembly for the red-colored HP Mini 1000 (includes 1 webcam,
1 microphone, 1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

512143-001 10.2-inch, WSVGA, AntiGlare display assembly for the Compaq Mini 700 (includes 1 webcam, 1 microphone,
1 speaker box, and 2 WLAN antenna transceivers/cables; WWAN is optional)

512189-001 Base enclosure (includes 4 rubber feet) for the red-colored HP Mini 1000

512190-001 Top cover (includes TouchPad) for the red-colored HP Mini 1000

512191-001 Speaker grill for the red-colored HP Mini 1000

512192-001 Plastics Kit for the red-colored HP Mini 1000 (see Plastics Kit on page 21 for more Plastics Kit spare part
number information)

512321-001 HP Mini Sleeve for the HP Mini 1000

512329-001 HP Mini Mobile Drive, 2-GB

512330-001 HP Mini Mobile Drive, 4-GB

512331-001 HP Mini Mobile Drive, 8-GB

512851-001 3-cell, 26-Wh Li-Pol battery for the red-colored HP Mini 1000 (for use in all countries and regions except
Germany)

512851-002 3-cell, 26-Wh Li-Pol battery for the red-colored HP Mini 1000 (for use in Germany only)

512852-001 30-W UMA AC adapter (for use in Germany only)

515099-001 Heat sink assembly (includes replacement thermal material)

515207-001 Display Hinge Kit for use with 10.1-inch panels on the Compaq Mini 700
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Spare part
number

Description

515208-001 Display Cable Kit with WLAN for use with 10.1-inch panels on the Compaq Mini 700 (includes microphone
assembly and display/webcam cable)

515209-001 Display Cable Kit with WWAN for use with 10.1-inch panels on the Compaq Mini 700 (includes microphone
assembly and display/webcam cable)

515210-001 Display Rubber Kit for use with 10.1-inch panels on the Compaq Mini 700

515211-001 Display Screw Kit for use with 10.1-inch panels on the Compaq Mini 700

515212-001 Foil shield for use with 10.1-inch display panels on the Compaq Mini 700

515213-001 Webcam module for use with 10.1-inch panels on the Compaq Mini 700

NOTE: The webcam module spare part kit does not include a webcam cable. An integrated display/webcam
cable is included in the Display Cable Kit, spare part number 515208-001 (with WLAN) or 515209-001 (with
WWAN).

517577-001 2048-MB memory module (PC2-4200, 533-MHz, DDR2) for the HP Mini 1000 only
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the device, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Cables and connectors
CAUTION: When servicing the device, be sure that cables are placed in their proper locations during
the reassembly process. Improper cable placement can damage the device.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Preliminary replacement requirements 29



Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
device, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the device. If you are unsure whether the device
is off or in Hibernation, turn the device on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the device when you are removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the device you are servicing has an unknown user password, follow these steps to clear the password:

NOTE: These steps also clear CMOS.

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 52).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the device.

8. Connect AC power to the device. Do not reinsert any batteries at this time.

9. Turn on the device.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 49 screws, in 7 different sizes, that must be removed, replaced, or loosened when
servicing the device. Make special note of each screw size and location during removal and replacement.

Service tag
The service tag, affixed to the bottom of the device, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the device.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the device.

(5) Warranty period: This number describes the duration of the warranty period for the device.

When ordering parts or requesting information, provide the device serial number and model description
provided on the service tag.
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Device feet
The device feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 504613-001. There are 4 rubber feet that are installed on the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

3-cell, 26-Wh Li-Pol battery for the HP Mini 1000 and Compaq Mini 700 504610-001

3-cell, 26-Wh Li-Pol battery for the red-colored HP Mini 1000
(for use in all countries and regions except Germany)

512851-001

3-cell, 26-Wh Li-Pol battery for the red-colored HP Mini 1000 (for use in Germany only) 512851-002

Before disassembling the device, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery:

1. Turn the device upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Pivot the battery (2) upward and remove the battery from the device (3).

To install the battery, insert the rear edge of the battery into the battery bay and pivot the battery
downward until it is seated. The battery release latch automatically locks the battery into place.
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Memory module

Description Spare part number

512-MB (PC2-4200, 533-MHz, DDR2) 504599-001

1024-MB (PC2-4200, 533-MHz, DDR2) 504600-001

2048-MB (PC2-4200, 533-MHz, DDR2) (HP Mini 1000 only) 517577-001

Before removing the memory module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

Remove the memory module:

1. Slide the right battery release latch to the inside or “unlocked” position to reveal the release latch
for the memory module compartment cover. Use a thin, narrow tool to slide the release latch to the
outside or “unlocked” position (1). (The edge of the cover rises away from the device.) 

2. Remove the cover (2). The memory module compartment cover is included in the Plastics Kit, spare
part number 512192-001 for the red-colored HP Mini 1000 or 507317-001 for all other models of
the HP Mini 1000 and the Compaq Mini 700.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the device.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard
NOTE: For a comprehensive list of spare part numbers, see the Sequential part number listing
on page 24.

Description Spare part number Description Spare part number

For use with standard device
models

504611-xx1 For use with red-colored
HP Mini 1000 models only

509650-xx1

Before removing the keyboard, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

Remove the keyboard:

1. Remove the Phillips PM1.6×4.0 screw (1) and the Phillips PM1.6×6.0 screw (2) that secure the
keyboard to the device.

2. Turn the device display-side up, with the front toward you.

3. Open the device as far as possible.
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4. Grasp the tabs (1) on the outer edges of the keyboard and lift the rear edge (2) until the keyboard
rests at an angle. Then slide the keyboard back until it rests on the display assembly (3).

5. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached.

6. Disconnect the cable (2), and then remove the keyboard.

Reverse this procedure to install the keyboard.
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Mass storage devices
NOTE: Each hard drive spare part kit and solid-state drive spare part kit includes a cable and bracket.

Description Spare part number

8-GB solid-state drive 507313-001

16-GB solid-state drive 507314-001

60-GB, 4200-rpm hard drive 504601-001

Before removing the hard drive or solid-state drive, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the keyboard (see Keyboard on page 40).

To remove the hard drive:

1. Release the ZIF connector (1) to which the SIM card cable is attached. The end of the cable lies
across the top of the hard drive.

2. Disconnect the SIM card cable (2), and then detach the tape from the top of the hard drive.

3. Release the low insertion force (LIF) connector (1) to which the hard drive cable is attached.

4. Disconnect the hard drive cable (2).

5. Remove the two Phillips PM2.0×4.5 screws (3) that secure the hard drive to the device.
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6. Lift the hard drive (4) up and slide it out of the drive bay.

Reverse this procedure to install the hard drive.

To remove the solid-state drive:

1. Release the ZIF connector (1) to which the SIM card cable is attached. The end of the cable lies
across the top of the solid-state drive.

2. Disconnect the SIM card cable (2), and then detach the tape from the top of the solid-state drive.

3. Release the LIF connector (1) to which the solid-state drive cable is attached.

4. Disconnect the solid-state drive cable (2).

5. Remove the two Phillips PM2.0×4.5 screws (3) that secure the drive bracket to the device.
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6. Remove the drive bracket (4) from the drive bay.

7. Remove the three Phillips PM2.0×3.0 screws (1) that secure the solid-state drive to the bracket.

8. Remove the solid-state drive (2) from the bracket.

Reverse this procedure to install the solid-state drive.
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Top cover

Description Spare part number

Top cover (includes TouchPad) 504612-001

Before removing the top cover, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the keyboard (see Keyboard on page 40).

6. Remove the hard drive or solid-state drive (see Mass storage devices on page 42).

1. Turn the device upside down, with the front toward you.

2. Use a thin, flat tool to remove the four screw covers (1).

There are three different variations of the covers, each of which is shaped like a rounded square:

● The two front covers are short in height and are notched to prevent incorrect insertion.

● The right rear cover is taller in height and is notched.

● The left rear cover is taller in height and is not notched.

3. Remove the four Phillips PM2.5×7.0 screws (2) that secure the top cover to the base enclosure.

4. Turn the device right-side up, with the front toward you.
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5. Open the device as far as possible.

6. Remove the Phillips PM2.0×4.5 screw (1) and the Phillips PM2.5×5.0 screw (2) that secure the top
cover to the base enclosure.

7. Lift the rear edge of the top cover (1) and swing it up. Then slide the top cover back slightly to rest
against the display assembly (2) at an angle.

8. Release the ZIF connector (1) to which the TouchPad button board cable is connected.
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9. Disconnect the TouchPad button board cable (2) from the system board, and then remove the top
cover.

Reverse this procedure to install the top cover.
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WLAN module

Description Spare part number

Broadcom 4312 802.11/b/g WLAN module for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the U.S. Virgin Islands, and the United States

504593-001

Broadcom 4312 802.11/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-002

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)
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Remove the WLAN module:

1. Detach the black Mylar covering (not illustrated) that surrounds the fan.

2. Several system cables are routed through a channel between the fan and the battery bay. Detach
the black tape from the cables.

3. Disconnect the wireless antenna cables (1) from the terminals on the WLAN module.

4. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the device.)

5. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HP un2400 Mobile Broadband Module 483377-002

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support through Help and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)
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Remove the WWAN module:

1. Detach the black Mylar covering from the WWAN module. The covering is secured by adhesive.

2. Detach the aluminum foil and tape (not illustrated) from the wireless antenna cables, and then
disconnect the wireless antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the Phillips PM2.0×3.0 screw (2) that secures the WWAN connector bracket (3) to the
system board. (The edge of the module opposite the slot rises away from the device.)

4. Remove the WWAN module (4) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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RTC battery

Description Spare part number

RTC battery 507707-001

NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Before removing the real-time clock (RTC) battery, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board.

NOTE: The RTC battery is attached to the system board with double-sided tape.

Reverse this procedure to install the RTC battery.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 507708-001.

Description Spare part number

Bluetooth module 507706-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Detach the Bluetooth module (2) from the system board.

NOTE: The Bluetooth module is attached to the system board with double-sided tape.

Reverse this procedure to install the Bluetooth module.
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System board
NOTE: The system board spare part kit includes a processor and replacement thermal material.

Description Spare part number

System board equipped with 1.6-GHz processor 504592-001

Before removing the system board, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 48)

● WWAN module, if included (see WWAN module on page 50)

● RTC battery (see RTC battery on page 52)

● Bluetooth module (see Bluetooth module on page 53)

● Heat sink assembly (see Heat sink assembly on page 57)

Remove the system board:

1. Disconnect the wireless antenna cables from the terminals on the WLAN module (see WLAN
module on page 48).

2. If the device also includes a WWAN module, disconnect the wireless antenna cables from the
terminals on the WWAN module (see WWAN module on page 50).
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3. Disconnect the following cables from the system board:

(1) Speaker cables

(2) Microphone cable

(3) Fan cable

(4) Power cable

(5) Display panel cable

4. Remove the two Phillips PM1.6×2.5 screws (1) that secure the actuators for the power switch and
wireless on/off switch to the system board.

5. Remove the actuators (2).

NOTE: The actuators are included in the Bracket Kit, spare part number 507318-001.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the USB connector bracket to the base
enclosure.
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7. Remove the USB connector bracket (2).

NOTE: The USB connector bracket is included in the Bracket Kit, spare part number 507318-001.

8. Remove the Phillips PM2.0×4.5 screw that secures the system board to the base enclosure.
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9. Grasp the system board at its midpoint (1) and lift the right side (2) up. Then remove the system
board (3) from the base enclosure.

Reverse the procedure to install the system board.

Heat sink assembly
NOTE: The heat sink assembly spare part kit includes replacement thermal material.

Description Spare part number

Heat sink assembly 515099-001

Before removing the heat sink assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

d. WLAN module (see WLAN module on page 48)

Remove the heat sink assembly:

1. Remove the two Phillips PM1.6×2.5 screws (1) that secure the heat sink assembly to the system
board.
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2. Remove the heat sink assembly (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink
assembly and system board components, it may be necessary to move the heat sink assembly
from side to side to detach the assembly.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
assembly and the system board each time the heat sink assembly is removed. Thermal paste is
used on the processor (1), the heat sink section (2) that services the processor, the Northbridge
chip (3), and the heat sink section (4) that services the Northbridge chip. Replacement thermal
material is included with all heat sink assembly and system board spare part kits.

Reverse this procedure to install the heat sink assembly.
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Fan

Description Spare part number

Fan 504615-001

NOTE: To properly ventilate the device, allow at least a 7.6-cm (3-inch) clearance on the left side of
the device. The device uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the device.

Before removing the fan, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

d. System board (see System board on page 54)

Remove the fan:

1. Detach the black mylar covering and tape (see WLAN module on page 48), and then move the
cables aside.

2. Remove the Phillips PM2.0×3.0 screw (1) and the Phillips PM2.0×4.5 screw (2) that secure the fan
to the base enclosure.
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3. Remove the fan (3).

Reverse this procedure to install the fan.
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USB board and internal display switch
NOTE: The internal display switch module is included in the Cable Kit, spare part number 507708-001.

Description Spare part number

USB board 506336-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40).

b. Hard drive (see Mass storage devices on page 42).

c. Top cover (see Top cover on page 45).

d. Fan (see Fan on page 59).

Remove the USB board:

1. Disconnect the internal display switch cable (1) from the USB board.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the DC jack bracket to the base enclosure.

3. Remove the DC jack bracket (1) and USB board (2) from the base enclosure.
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4. Detach the SIM card cable (3). The SIM card cable is attached to the battery bay with tape.

Reverse this procedure to install the USB board.

If it is necessary to replace the internal display switch module, perform the following steps:

1. Remove the Phillips PM2.0×3.0 screw (1) that secures the internal display switch bracket to the
base enclosure.

2. Remove the internal display switch bracket (2) and module (3) from the base enclosure.

Reverse this procedure to install the internal display switch.

62 Chapter 4   Removal and replacement procedures



Display assembly
NOTE: Each display assembly spare part kit includes 1 webcam, 1 microphone, 1 speaker box, and
2 WLAN antenna transceivers/cables; WWAN is optional.

NOTE: 10.1-inch display assembly components are not sold separately for the HP Mini 1000. The
complete display assembly is available as spare part number 509696-001 for the red-colored
HP Mini 1000 or 507312-001 for all other models of the HP Mini 1000.

NOTE: 10.2-inch display assembly components are not sold separately. The complete display
assembly is available as spare part number 512140-001 for the red-colored HP Mini 1000, 507310-001
for all other models of the HP Mini 1000, or 512143-001 for the Compaq Mini 700.

Description Spare part number

8.9-inch, WSVGA, BrightView (HP Mini 1000) 507309-001

8.9-inch WSVGA BrightView (Compaq Mini 700) 508638-001

10.1-inch standard-definition AntiGlare (HP Mini 1000) 507312-001

10.1-inch standard-definition AntiGlare (red-colored HP Mini 1000) 509696-001

10.1-inch standard-definition AntiGlare (Compaq Mini 700) 509697-001

10.2-inch WSVGA AntiGlare (HP Mini 1000) 507310-001

10.2-inch WSVGA AntiGlare (red-colored HP Mini 1000) 512140-001

10.2-inch WSVGA AntiGlare (Compaq Mini 700) 512143-001

See Display assembly components on page 17 for more spare part information.

Before removing the display assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 42)

c. Top cover (see Top cover on page 45)

CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other device components.

Remove the display assembly:

1. Remove the three remaining Phillips PM2.5×5.0 screws (1) that secure the display assembly to
the device.
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2. Remove the display assembly (2).

3. If it is necessary to replace the speaker assembly, perform the following steps:

a. Squeeze the sides of the speaker grill together to release the pressure clips, and then remove
the speaker grill. The speaker grill is available as spare part number 506338-001.

b. Remove the two Phillips PM2.0×4.5 screws (1) that secure the speaker assembly to the
display enclosure. All display assembly subcomponent screws are available in the Display
Screw Kit, spare part number 509700-001 for all 8.9-inch panels or 515211-001 for 10.1-inch
panels (Compaq Mini 700 only).
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c. Remove the speaker assembly (2). The speaker assembly is available as spare part number
506335-001.

4. If it is necessary to replace the display hinges, perform the following steps:

a. Remove the two Phillips PM2.0×4.5 screws (1) that secure each hinge to the display
enclosure.

b. Remove the hinges (2). The hinges are available in the Display Hinge Kit, spare part number
504596-001 for all 8.9-inch panels or 515207-001 for 10.1-inch panels (Compaq Mini 700
only).

5. If it is necessary to replace the display bezel, perform the following steps:

a. Flex the inside edges of the bottom (1), left and right sides (2), and the top (3) of the display
bezel until the bezel disengages from the display enclosure.
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b. Remove the display bezel (4). The spare part numbers for the 8.9-inch display bezels are
506333-001 (HP Mini 1000) and 509701-001 (Compaq Mini 700). The spare part number for
the 10.1-inch display bezel is 509704-001 (Compaq Mini 700 only).

6. If it is necessary to replace the webcam module, perform the following steps:

a. Open the tab built into the display enclosure shielding that secures the microphone cable, and
then release the microphone (1) from its clip.

b. Release the ZIF connector (2) to which the integrated display/webcam cable is attached.

c. Disconnect the display/webcam cable (3) from the display enclosure.

The microphone assembly and display/webcam cable for all 8.9-inch panels is available in
the Display Cable Kit, spare part number 504597-001 (with WLAN) or 504598-001 (with
WWAN).

The microphone assembly and display/webcam cable for 10.1-inch panels (Compaq Mini 700
only) is available in the Display Cable Kit, spare part number 515208-001 (with WLAN) or
515209-001 (with WWAN).
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d. Remove the two Phillips PM2.0×3.0 screws (1) that secure the webcam module to the display
enclosure.

e. Remove the webcam module (2). The webcam module is available as spare part number
504594-001 for all 8.9-inch panels or 515213-001 for 10.1-inch panels (Compaq Mini 700
only).

7. If it is necessary to replace the display panel, perform the following steps:

a. Remove the nine Phillips PM2.0×3.0 screws that secure the display panel to the display
enclosure.

b. Remove the wireless antenna cables (1) from the clips and routing channels built into the
display and brackets (2).
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c. Remove the display panel (3) from the display enclosure. An 8.9-inch display panel for the
HP Mini 1000 and the Compaq Mini 700 is available as spare part number 509698-001. A
10.1-inch display panel for the Compaq Mini 700 only is available as spare part number
509703-001.

8. If it is necessary to replace the display panel brackets, perform the following steps:

a. Remove the four Phillips PM2.0×3.0 screws (1) that secure the brackets to the display panel.

b. Remove the brackets (2). The brackets are available in the Display Hinge Kit, spare part
number 504596-001 for all 8.9-inch panels or 515207-001 for 10.1-inch panels
(Compaq Mini 700 only).
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9. If it is necessary to replace the wireless antenna transceivers and cables, detach the cables from
the adhesive that secures them to the display enclosure, and then remove the cables.

The wireless antenna transceivers and cables for all 8.9-inch panels are available in the Display
Cable Kit, spare part number 504597-001 (with WLAN) or 504598-001 (with WWAN).

The wireless antenna transceivers and cables for 10.1-inch panels (Compaq Mini 700 only) are
available in the Display Cable Kit, spare part number 515208-001 (with WLAN) or 515209-001 (with
WWAN).

Reverse this procedure to reassemble and install the display assembly.
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5 Setup Utility

Starting the Setup Utility
The Setup Utility is a ROM-based information and customization utility that can be used even when your
Windows operating system is not working.

The utility reports information about the device and provides settings for startup, security, and other
preferences.

To start the Setup Utility, turn on or restart the device, and then press f10 while the “F10 = BIOS Setup
Options” message is displayed in the lower-left corner of the screen.

Using the Setup Utility
Changing the language of the Setup Utility

The following procedure explains how to change the language of the Setup Utility. If the Setup Utility is
not already running, begin at step 1. If the Setup Utility is running, begin at step 2.

1. To open the Setup Utility, turn on or restart the device, and then press f10 while the "F10 = BIOS
Setup Options" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select System Configuration > Language,  and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit the Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change becomes effective immediately.
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Navigating and selecting in the Setup Utility
Because the Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

● To choose a menu or a menu item, use the arrow keys.

● To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or f5 or f6.

● To select an item, press enter.

● To close a text box or return to the menu display, press esc.

● To display additional navigation and selection information while the Setup Utility is open,
press f1.

Displaying system information
The following procedure explains how to display system information in the Setup Utility. If the Setup
Utility is not already running, begin at step 1. If the Setup Utility is running, begin at step 2.

1. To open the Setup Utility, turn on or restart the device, and then press f10 while the "F10 = BIOS
Setup Options" message is displayed in the lower left corner of the screen.

2. Select the Main menu. System information such as the system time and date and identification
information about the device is displayed.

3. To exit the Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

Restoring default settings in the Setup Utility
The following procedure explains how to restore the Setup Utility default settings. If the Setup Utility is
not already running, begin at step 1. If the Setup Utility is running, begin at step 2.

1. To open the Setup Utility, turn on or restart the device, and then press f10 while the “F10 = BIOS
Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit the Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

The Setup Utility default settings go into effect when the device restarts.

NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.
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Exiting the Setup Utility
You can exit the Setup Utility with or without saving changes.

● To exit the Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Use the arrow
keys to select Exit > Exit Saving Changes, and then press enter.

● To exit the Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Use the arrow
keys to select Exit > Exit Discarding Changes, and then press enter.

After either choice, the device restarts in Windows.

Setup Utility menus
The menu tables in this section provide an overview of Setup Utility options.

NOTE: Some of the Setup Utility menu items listed in this chapter may not be supported by your device.

Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about the device.

● View specification information about the processor, memory size, and system
BIOS.

Security menu

Select To do this

Administrator password Enter, change, or delete an administrator password.

Power-on password Enter, change, or delete a power-on password.
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System Configuration menu

Select To do this

Language Support Change the Setup Utility language.

Processor C4 State Enable/disable the processor C4 sleep state.

Boot Options Set the following boot options:

● f10 and f12 Delay (sec.)—Set the delay for the f10 and f12 functions of the
Setup Utility in intervals of 5 seconds each (0, 5, 10, 15, 20).

● Internal Network Adapter boot—Enable/disable boot from Internal Network
Adapter.

● Boot Order—Set the boot order for:

◦ Internal hard drive (select models only)

◦ USB Floppy

◦ USB CD/DVD ROM Drive

◦ USB Diskette on Key

◦ USB Hard drive

◦ USB Card Reader

◦ Network adapter

Diagnostics menu

Select To do this

Hard Disk Self Test (select models only) Run a comprehensive self-test on the hard drive.

Memory Test Run a diagnostic test on the system memory.
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6 Specifications

Device specifications
 Metric U.S.

Dimensions

Depth 16.67 cm 6.56 in

Width 26.17 cm 10.30 in

Height 2.52 cm 0.99 in

Weight

10.2-in. LCD, equipped with a 3-cell battery, 60-GB hard drive,
1-GB memory, WLAN module, and 2 wireless antennae

1.11 kg 2.45 lb

10.2-in. LCD, equipped with a 3-cell battery, 8-GB solid-state
drive, 1-GB memory, WLAN module, and 2 wireless antennae

1.09 kg 2.40 lb

8.9-in. LCD, equipped with a 3-cell battery, 60-GB hard drive,
1-GB memory, WLAN module, and 2 wireless antennae

1.08 kg 2.38 lb

8.9-in. LCD, equipped with a 3-cell battery, 8-GB solid-state
drive, 1-GB memory, WLAN module, and 2 wireless antennae

1.02 kg 2.25 lb

Input power

Operating voltage 19 V dc @ 1.58 A – 30 W

Operating current 1.58 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 65°C -4°F to 149°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 0% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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8.9-inch, WSVGA, BrightView display specifications
 Metric U.S.

Dimensions

Height 11.34 cm 4.47 in

Width 19.51 cm 7.68 in

Diagonal 22.61 cm 8.90 in

Number of colors 262,144

Contrast ratio 300:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.1905 × 0.189 mm

Format 1024 × 600

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 3.0 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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10.1-inch, standard-definition, AntiGlare display
specifications

 Metric U.S.

Dimensions

Height 23.45 cm 9.23 in

Width 14.30 cm 5.62 in

Diagonal 25.55 cm 10.05 in

Number of colors 262,144

Contrast ratio 400:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.2175 × 0.2175 mm

Format 1024 × 576

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 3.2 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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10.2-inch, WSVGA, AntiGlare display specifications
 Metric U.S.

Dimensions

Height 12.53 cm 4.93 in

Width 22.27 cm 8.77 in

Diagonal 25.55 cm 10.06 in

Number of colors 262,144

Contrast ratio 400:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.2175 × 0.2175 mm

Format 1024 × 576

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 3.0 W

Viewing angle +/-40° horizontal, +20/-40° vertical (typical)
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Hard drive specifications
 60-GB *

Dimensions

Height 9.5 mm

Width 70 mm

Weight 101 g

Interface type PATA

Transfer rate 100 MB/sec

Security ATA security

Seek times (typical read, including setting)

Single track 3 ms

Average 13 ms

Maximum 24 ms

Logical blocks 117,210,240

Disc rotational speed 4200 rpm

Operating temperature  

* 1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications
Performance

Transfer modes supported UDMA 0-4, Multiword-DMA 0-2, PIO 0-4

Sustained read 39 MB/sec

Sustained write 17 MB/sec

Characteristics

Interface Parallel ATA (PATA)

MLC NAND flash capacity 8 GB, 16 GB

Electrical specifications

DC supply voltage 3.3 V +/– 5%

Standby current 300 µA (typical)

Active current Read = 130 mA (typical)

Write = 120 mA (typical)

Environmental specifications

Operating temperature 0°C to +70°C (32°F to 158°F)

Storage temperature -25°C to +85°C (-13°F to 185°F)

Operating altitude up to 24,384 m (80,000 feet)

Humidity 5% to 90% non-condensing

Shock 1,000 g

Acoustic noise 0 dB

Vibration 15 g (peak to peak)

Physical specifications

Connector 40-pin ZIF connector

Weight (8-GB model) 5.5 g

Weight (16-GB model) 7.0 g

Dimensions (8-GB model) 54 × 32 × 2.6 mm

Dimensions (16-GB model) 54 × 32 × 3.75 mm

Regulations and compliance RoHS, China RoHS, SGS ROHS, FCC, CE
UL – PCB Only
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1 * Not applicable

DMA2 * Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural PS/2 Keyboard

IRQ8 System CMOS/real-time clock

IRQ9 * Microsoft ACPI-compliant system

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Intel® 82801G (ICH7 Family) SMBus Controller—27DA

IRQ16 Broadcom 802.11b/g WLAN no. 2

Intel 82801G (ICH7 Family) PCI Express Root Port—27D0

Intel 82801G (ICH7 Family) USB Universal Host Controller—27CB

Microsoft UAA Bus Driver for High Definition Audio

Mobile Intel 945 Express Chipset Family

IRQ17 Intel 82801G (ICH7 Family) PCI Express Root Port—27D2

IRQ18 Intel 82801G (ICH7 Family) USB Universal Host Controller—27CA

IRQ19 Intel 82801G (ICH7 Family) USB Universal Host Controller—27C9

IRQ23 Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8

Intel 82801G (ICH7 Family) USB2 Enhanced Host Controller—27CC

* Default configuration
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller

000 - CF7 PCI bus

010 - 01F Motherboard resources

020 - 021 Programmable interrupt controller

022 - 03F Motherboard resources

040 - 043 System timer

044 - 05F Motherboard resources

060 - 060 Standard 101-/102-Key or Microsoft® Natural PS/2 Keyboard

061 - 061 System speaker

062 - 062 Microsoft ACPI-Compliant Embedded Controller

063- 063 Motherboard resources

064 - 064 Standard 101-/102-Key or Microsoft Natural PS/2 Keyboard

065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller

067 - 06F Motherboard resources

070 - 071 System CMOS/real-time clock

072 - 07F Motherboard resources

080 - 080 Motherboard resources

081 - 083 DMA controller

084 - 086 Motherboard resources

087 - 087 DMA controller

088 - 088 Motherboard resources

089 - 08B DMA controller

08C - 08E Motherboard resources

08F - 08F DMA controller

090 - 09F Motherboard resources

0A0 - 0A1 Programmable interrupt controller

0A2 - 0BF Motherboard resources

0C0 - 0DF DMA controller

0E0 - 0EF Motherboard resources

0F0 - 0FF Numeric data processor

1F0 - 1F7 Primary IDE channel

274 - 277 ISAPNP Read Data Port
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I/O address (hex) System function (shipping configuration)

279 - 279 ISAPNP Read Data Port

3B0 - 3BB Mobile Intel® 945 Express Chipset Family

3C0 - 3DF Mobile Intel 945 Express Chipset Family

3F6 - 3F6 Primary IDE channel

400 - 41F Intel 82801G (ICH7 Family) SMBus Controller—27DA

480 - 4BF Motherboard resources

4D0 - 4D1 Motherboard resources

500 - 501 Motherboard resources

800 - 87F Motherboard resources

A79 - A79 ISAPNP Read Data Port

0D00 - FFFF PCI bus

D480 - D49F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8

D800 - D81F Intel 82801G (ICH7 Family) USB Universal Host Controller—27CA

D880 - D89F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C9

DC00 - DC1F Intel 82801G (ICH7 Family) USB Universal Host Controller—27C8

DC80 - DC87 Mobile Intel 945 Express Chipset Family

E000 - EFFF Intel 82801G (ICH7 Family) PCI Express Root Port—27D2

FFA0 - FFAF Intel 82801G (ICH7 Family) Ultra ATA Storage Controllers—27DF
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System memory map specifications
Memory address System function

00000000 - 0009FFFF System board

000A0000 - 000BFFFF Mobile Intel® 945 Express Chipset Family

000A0000 - 000BFFFF PCI bus

000C0000 - 000CFFFF System board

000D0000 - 000DFFFF PCI bus

000E0000 - 000FFFFF System board

00100000 - 3F7FFFFF System board

3F800000 - DFFFFFFF PCI bus

D0000000 - DFFFFFFF Mobile Intel 945 Express Chipset Family

E0000000 - E3FFFFFF Motherboard resources

E4000000 - FED8FFFF PCI bus

FE880000 - FE8FFFFF Mobile Intel 945 Express Chipset Family

FE937C00 - FE937FFF Intel 82801G (ICH7 Family) USB2 Enhanced Host Controller—27CC

FE938000 - FE93BFFF Microsoft® UAA Bus Driver for High Definition Audio

FE940000 - FE97FFFF Mobile Intel 945 Express Chipset Family

FE980000 - FE9FFFFF Mobile Intel 945 Express Chipset Family

FEA00000 - FEAFFFFF Intel 82801G (ICH7 Family) PCI Express Root Port—27D0

FEAFC000 - FEAFFFFF Broadcom 802.11b/g WLAN

FEB00000 - FEBFFFFF Intel 82801G (ICH7 Family) PCI Express Root Port—27D2

FEC00000 - FEC00FFF Motherboard resources

FED13000 - FED19FFF System board

FED1C000 - FED1FFFF Motherboard resources

FED20000 - FED3FFFF Motherboard resources

FED40000 - FED8FFFF Motherboard resources

FED90000 - FFFFFFFF System board

FEE00000 - FEE00FFF Motherboard resources
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the device. All screws listed in this section are available in the Screw Kit, spare part number 504614-001;
or in the Display Screw Kit, spare part number 509700-001 for all 8.9-inch panels or 515211-001 for
10.1-inch panels (Compaq Mini 700 only).

Phillips PM1.6×2.5 screw

Color Quantity Length Thread Head diameter

Silver 4 2.5 mm 1.6 mm 3.0 mm

Where used: Two screws that secure the power and wireless switch actuators to the system board
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Where used: Two screws that secure the heat sink to the system board

Phillips PM1.6×4.0 screw

Color Quantity Length Thread Head diameter

Silver 1 4.0 mm 1.60 mm 3.5 mm

Where used: One screw that secures the keyboard to the device
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Phillips PM1.6×6.0 screw

Color Quantity Length Thread Head diameter

Black 1 6.0 mm 1.60 mm 3.5 mm

Where used: One screw that secures the keyboard to the device
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 24 (WLAN only)
25 (with WWAN)

3.0 mm 2.0 mm 4.0 mm

Where used: Three screws that secure the solid-state drive to its bracket

Where used: One screw that secures the WLAN module to the system board

Phillips PM2.0×3.0 screw 87



Where used: One screw that secures the WWAN connector bracket to the system board

Where used: Two screws that secure the USB connector bracket to the system board

Where used: One screw that secures the fan to the base enclosure
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Where used: One screw that secures the DC jack bracket to the base enclosure

Where used: One screw that secures the internal display switch bracket to the base enclosure

Where used: Two screws that secure the webcam module to the display enclosure
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Where used: Nine screws that secure the display panel to the display enclosure

Where used: Four screws that secure the left and right display panel brackets to the display panel
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Phillips PM2.0×4.5 screw

Color Quantity Length Thread Head diameter

Silver 10 4.5 mm 2.0 mm 4.0 mm

Where used: Two screws that secure the hard drive to the device

Where used: Two screws that secure the solid-state drive bracket to the device
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Where used: One screw that secures the top cover to the device

Where used: One screw that secures the fan and DC jack bracket to the base enclosure

Where used: Two screws that secure the speaker assembly to the display enclosure
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Where used: Four screws that secure the display hinges to the display assembly

Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Silver 4 5.0 mm 2.5 mm 4.5 mm

Where used: Four screws that secure the display assembly and top cover to the device

Phillips PM2.5×5.0 screw 93



Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 4 7.0 mm 2.5 mm 4.0 mm

Where used: Four screws that secure the top cover to the base enclosure
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8 Backup and recovery

Backing up your information
NOTE: You can recover only the files that you have previously backed up. HP recommends that you
use the Windows backup utility to create a hard drive backup as soon as you set up your device.

With the Windows backup utility, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesirable changes to your device by
restoring the device to an earlier state

● Scheduling backups at specific intervals or events

NOTE: The Windows backup utility backs up only data files. The operating system, drivers, and
programs are located on the operating system disc and the System Recovery disc that are included with
the device.

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the device is repaired or restored

● Before you add or modify hardware or software
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Backup suggestions
● Connect the device to external power before performing backup and recovery procedures.

● Create system recovery points.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document and click Edit > Paste.

The screen image is added to the document.

4. Save the document.

Backing up individual files or folders
You can back up individual files or folders to an optional external hard drive or to a network drive.

NOTE: This process will take several minutes, depending on the file size and the speed of the device.

To back up individual files or folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Follow the on-screen instructions.
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Backing up all files and folders
When you back up all files and folders, you are saving all personal files and folders, all system files, and
configuration settings at one time.

NOTE: When you back up all files and folders, this does not include the operating system or programs.

NOTE: This process may take over an hour, depending on your device speed and the amount of data
being stored.

NOTE: A copy of the backup files can be stored on an optional external hard drive or on a network
drive.

To back up all files and folders:

1. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

2. Click Next.

3. Click Backup files and settings, and then click Next.

4. Click All information on this computer, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up system modifications since your last backup, you are creating system recovery
points. This allows you to save a snapshot of your hard drive at a specific point in time. You can then
recover back to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > Accessories > System Tools > System Restore.

The System Restore window opens.

2. Click Create a new restore point, and then click Next.

3. Type a short description of the restore point. This will be used as the name of the restore point.

4. Click Create.

5. Follow the on-screen instructions.
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Scheduling backups
You can schedule backups for the entire system, for recovery points, or for specific files and folders.
Backups can be scheduled at specific intervals (daily, weekly, or monthly) or at specific events, such as
at system restart or when you log on.

To schedule backups:

1. Select Start > All Programs > Accessories > System Tools > Schedule Tasks.

The Schedule Tasks window opens.

2. Double-click Add Scheduled Task, and then click Next.

3. Select Backup in the Application list, and then click Next.

4. Type a name for the backup, select when you want the backup to be performed, and then click
Next.

5. Enter your user name, password, and password again to confirm. Click Next, and then click
Finish.

Performing a recovery
The Windows backup utility helps you recover important files that you have previously backed up in
case of system failure.

NOTE: To recover the operating system and programs, use the operating system disc and the System
Restore disc that are included with the device.

Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard page opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the device permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the device meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the device is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the device.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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27,  63
display bezel

illustrated 17
removal 65
spare part number 17,  26, 

66
Display Cable Kit, spare part

number 18,  25,  66,  69
display component recycling 103
display enclosure

illustrated 18
spare part number 18,  25

Display Hinge Kit, spare part
number 18,  25,  65,  68

display hinge, removal 65
display panel

bracket removal 68
illustrated 18
removal 67
spare part number 18,  68

Display Rubber Kit, spare part
number 18,  27

Display Screw Kit, spare part
number 18,  27,  64

display specifications 75,  76,  77
drive light 8
drives

boot order 73
preventing damage 30

E
electrostatic discharge 31
esc key 6
Ethernet, product description 2
expansion port, product

description 3
external media cards, product

description 2

F
fan

removal 59
spare part number 14,  25, 

59
feet

locations 36
spare part number 36

File menu 72
flash storage drive, product

description 2
fn key 6
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foil shield, spare part number 18, 
26,  28

front components 8
function keys 6

G
graphics, product description 1
grounding equipment and

methods 33

H
hard drive

precautions 30
product description 2
removal 42
spare part number 14,  25, 

42
specifications 78

Hard Drive Hardware Kit, spare part
number 14,  25

headphone jack
location 10
pin assignments 99

heat sink assembly
removal 57
spare part number 57

HP Mini Mobile Drive Bay,
location 9

HP Mini Mobile Drive, spare part
number 22

I
I/O address specifications 81
in Setup Utility 70
internal display switch 4
internal media cards, product

description 2
interrupt specifications 80

J
jacks

audio-in 10
audio-out 10
headphone 10
microphone 10
network 10
RJ-45 10

K
keyboard

product description 3

removal 40
spare part number 14,  25, 

40
keys

esc 6
fn 6
function 6
Windows applications 6
Windows logo 6

L
left-side components 10
lights

battery 8
drive 8
power 8
power connector 10
TouchPad on/off 7
wireless 8

M
mass storage device

product description 2
removal 42
spare part number 14,  42

mass storage devices
illustrated 20
spare part numbers 20

memory map specifications 83
memory module

product description 1
removal 38
spare part number 15,  25, 

38
memory module compartment

cover
removal 38
spare part number 21

microphone 4
microphone assembly, spare part

number 18,  66
microphone jack

location 10
pin assignments 99

model name 1
modem, product description 2

N
network jack

location 10
pin assignments 100

O
operating system, product

description 3
optical drive, product

description 2

P
packing guidelines 32
panels, product description 1
password clearing 34
passwords 72
pin assignments

audio-in jack 99
audio-out jack 99
headphone jack 99
microphone jack 99
network jack 100
RJ-45 jack 100
Universal Serial Bus (USB)

port 100
plastic parts 29
Plastics Kit

contents 21
spare part number 15,  21, 

26,  27
pointing device

components 7
illustrated 7
product description 3

pointing device components
TouchPad 7
TouchPad buttons 7
TouchPad on/off button 7
TouchPad on/off light 7
TouchPad scroll zone 7

ports
expansion 10
product description 2
Universal Serial Bus (USB) 9, 

10
power connector light,

location 10
power cord

set requirements 101
spare part number 22,  24

power light 8
power requirements, product

description 3
power switch 8
processor, product description 1
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optical drive 2
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power requirements 3
processors 1
product name 1
security 3
serviceability 3
solid-state drive 2
webcam 2
wireless 2

product name 1

R
removal/replacement

preliminaries 29
procedures 35

right-side components 9
RJ-45 jack

location 10
pin assignments 100

RTC battery
removal 52
spare part number 15,  26, 

52
Rubber Kit, spare part

number 22,  25

S
Screw Kit

contents 84
spare part number 23,  25

screw listing 84

SD Card Reader 9
security cable connector 9
Security menu 72
security, product description 3
serial number 12,  35
service considerations 29
service tag 12,  35
serviceability, product

description 3
Setup Utility

accessing 70
changing the language 70
Diagnostics menu 73
Main menu 72
navigating and selecting 71
Security menu 72
System Configuration

menu 73
using 70

sleeve, spare part number 22, 
27

solid-state drive
product description 2
removal 42
spare part number 26,  42

solid-state drives
spare part number 14

speaker assembly
illustrated 17
removal 64
spare part number 17,  26, 

65
speaker grill

illustrated 17
removal 64
spare part number 17,  26, 

27,  64
speakers 4
specifications

device 74
display 75,  76,  77
hard drive 78
I/O addresses 81
interrupts 80
memory map 83
solid-state drive 79
system DMA 80

static-shielding materials 33
switches

internal display 4

power 8
wireless 8

system board
removal 54
spare part number 15,  24, 

54
System Configuration menu 73
system DMA 80
system information 72
system memory map 83

T
tools required 29
top components 4
top cover

removal 45
spare part number 14,  25, 

27,  45
TouchPad 7
TouchPad buttons 7
TouchPad components 7
TouchPad on/off button 7
TouchPad on/off light 7
TouchPad scroll zone 7
transporting guidelines 32

U
unknown password 34
USB board

removal 61
spare part number 61

USB board, spare part
number 15,  26

USB port
location 9,  10
pin assignments 100

V
vents 9,  10,  11

W
webcam 4
webcam module

illustrated 18
removal 66
spare part number 18,  67
spare part number 10.1-inch

panels 28
spare part number 8.9-inch

panels 25
webcam, product description 2
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Windows applications key 6
Windows logo key 6
wireless antenna

locations 5
removal 69
spare part number 18,  69

wireless antenna components 5
wireless light 8
wireless module, product

description 2
wireless switch 8
WLAN module

removal 48
spare part number 14,  24, 

48
workstation guidelines 32
WWAN module

removal 50
spare part number 50
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